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Abstract: 

This document describes Spb Diary 2.2, including new features added on Dec 22, 
2006 

 Spb Diary is a powerful feature-rich “all-in-one” Today plug-in for the most popular 
PIM applications.  
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Overview 
Spb Diary is a powerful “all-in-one” Today plug-in for your Calendar, Tasks, Contacts, 
Notes, Messages and Special Events. This program can deeply integrate with the most 
popular PIM applications (Pocket Outlook, Agenda Fusion, and Pocket Informant). Spb 
Diary Today plug-in has six tabs for your appointments, tasks, contacts, notes, 
messages, and special events. The form and content of each tab is highly 
customizable. Spb Diary supports configurable filters, photo contacts, category 
coloring, provides different grouping and sorting modes, and allows you to add as 
much supplementary graphic information as possible. 

Updated Features and Bug Fixes Spb Diary 2.2, Dec 18, 2006: 

• Mail folders support added  
• Context menus usability improved  
• Agenda One support added  
• PhatPad and Excel support added to Notes tab  
• Excluding folders in Notes tab implemented  
• Regenerating tasks (Pocket Informant) support added  
• Hiding Pocket Informant task templates implemented  
• Ability to see contact address in preview pop-up added  
• Showing contacts in both text and photo forms option added  
• Option to disable marking appointment conflicts added  
• Option to setup the appearance of multi-day tasks in Calendar added  
• Option to hide the collapse icon implemented  
• Changing tab order ability added  
• The behavior of the UP button in the search panel changed  
• Recording preview for WM5 case implemented  
• Wrong representation of some recurring appointments bug fixed  
• The bug with inability to set the plugin height less than 120 pixels in Pocket Plus 

fixed  

Software Features 

Six Today plug-ins in one 

Spb Diary provides a perfect Today plug-in for your Calendar, Tasks, Contacts, Notes, 
Messages, and Special Events represented with vertical tabs. 

View up to 31 days of upcoming events 

Spb Diary can simultaneously put on the screen your tasks and appointments for up 
to 31 days.  

Clear, intuitive and customizable interface 

All information represented in Spb Diary Today plug-in is informative, clear, and 
intuitive. A lot of actions can be performed from menus, including context menu. A 
time span incredibly simplifies the process of adding appointments with fixed 
duration. The form and content of each plug-in tab is highly customizable. You can 
configure fonts, indents, headers, item colors, counters, separating lines, time spans, 
status bars, group titles, date formats, long name handling, sorting modes, items to 
show, icons to show, and a lot of other details that will provide the most habitual 
interface of your Spb Diary Today plug-in. 
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Most frequent actions can be made without leaving the Today screen 

The most important and most frequent actions can be performed from Spb Diary 
Today plug-in using menus, including the context menu. 

Deep integration with all the most popular PIMs 

You can assign Spb Diary to your favorite PIM application installed on your device. 
This application will store your appointments, tasks, contacts and notes and will be 
used for viewing and editing these entries. 

Photo contacts 

Nothing can represent your contacts better than photos. You will find a contact by 
photo faster than from a text list. Contacts with photos can be put at the very top of 
the list. As long as people prefer to assign photos only to the most important 
contacts, they will always be before the user’s eyes. 

Smart filters and sorting modes 

You may wish to narrow down the displayed lists of your appointments, tasks, 
contacts and notes. Filters are perfect for this purpose. 

 

Installing Spb Diary 
After you’ve downloaded the Spb Diary distribution file you should install it to your 
mobile device. For a successful installation you will need a Windows® Mobile-based 
Pocket PC device attached to your Windows® desktop PC. You will also need 
Microsoft® ActiveSync™ software in order to install Spb Diary to your mobile device. 

When installing Spb Diary, you will be asked to accept the license agreement and 
prompted for the location where you want the software to be installed. During the 
install process you will also be asked if you wish to hide other PIM plug-ins from the 
Today screen.  

If you have Spb Diary 1.x installed on your 
device you do not need to remove it before 
installing the new one.  

During the installation process you should 
configure the following: 

• Use the following skin: You can select 
a skin used by Spb Diary. The skin will 
define the appearance of the entire 
application (almost all icons shown on 
the Today screen) 

• Automatically adjust plug-in height: 
If you keep it selected, Spb Diary plug-in 
will use all available unused screen 
space. If you want the plug-in to have a 
fixed height, please uncheck this check 
box. 

• Turn off the standard Pocket Outlook 

today plug-ins: If you keep this check box selected, then all the standard 
Pocket Outlook Today plug-ins (like Calendar, Tasks, etc) will removed from 
the Today screen and substituted with Spb Diary Today plug-in. 
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 Configuring Spb Diary  
As soon as Spb Diary is installed on your Pocket 
PC device it is ready to use. The Today plug-in 
automatically appears on your screen with all 
existing appointments, tasks, contacts, notes, 
messages and special events included. 
Additionally, you can customize some settings 
and program behavior. To enter the program 
options, tap-and-hold on the plug-in area and 
select Options from the context menu.  

 

 

 

 

 

 

Configuring General Options. Common tab.  

From the main tab of the General Options dialog 
you may customize the following:  

• Minimal Height/Plug-in height: This 
parameter depends on the state of the 
Auto height adjusting option. If auto 
height adjusting is switched on, then you 
can set the Minimal height of the plug-in. 
Otherwise you can set the exact height 
of Spb Diary plug-in in pixels. If the 
plug-in content does not fit this area you 
will be to scroll it with the scrollbar. 

• Auto height adjusting: If you select 
this option, Spb Diary will take all 
available unused real estate on the 
Today screen. 

• Integrated with: Spb Diary can operate 
as a Today plug-in for different PIM 
applications. Please select a PIM application that will be used for handling PIM 
operations. The PIM application you specify here will be used for viewing and 
editing your tasks, appointments, contacts, messages and notes. 
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• Header (Always Shown, Minimizable, Always Hidden): Select the desired 
header behavior.   

o Always Shown: The shown header provides you with access to 
grouping, sorting and filtering menus, which takes some screen space 

o Always Hidden: You will save some screen space, which is a critical 
resource for any Pocket PC user. All header menus will be available via 
context menu. 

o Minimizable: In this instance the header is handled manually. This is 
probably the best compromise. You can show or minimize the header 
manually. To hide the header, tap on . To show it, tap on the 
horizontal line shown instead of the header.  

• Action on double click (None, Open item, Edit item): Select an action to be 
performed when you double click on an item of your Spb Diary Today plug-in.  

o None: No action will be performed 

o Open item: An item will be opened in the selected PIM application 

o Edit item: An item will be opened for editing in the selected PIM 
application 

• Horizontal tabs in Spb Pocket Plus: If selected, Spb Diary tabs will be 
represented as horizontal tabs in Spb Pocket Plus plug-in (in case Spb Diary is 
not already integrated into it). 

 

Configuring General Options. Font  

In this dialog you can configure the font of all 
Today plug-in list items: appointments, tasks, 
contacts, and notes. 

• Use standard Today items font: If 
selected, the standard Today items font 
will be used for all Spb Diary Today 
items. Otherwise you can set the font 
manually by customizing the following: 

• Font and Size: Specify the desired font 
face and size and preview the sample 
text at the bottom of the dialog. 
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Configuring General Options. Group Style  

Here you can customize the appearance of item 
groups for appointments, tasks, contacts and 
notes: 

• Line position (Top, Center, Bottom): 
Select the position of a horizontal line 
that separates list entries. See the result 
at the bottom of the dialog. 

• Show counter: If you want to see how 
many entries there are within each 
group, keep this check box selected. 
Otherwise unselect it. 

 

 

 

 

 

 

 

 

Configuring General Options. Long Date  

In this dialog you can configure the long date 
format for the whole application. 

• Default for current regional settings: 
Keep this checkbox selected if you are 
satisfied with the date format specified in 
Regional Settings. Otherwise unselect 
this check box and select the desired 
data format from the drop-down list. 

• Don't use year: Select if you want to 
skip the year in dates. 

• Short year: Select if you want to show 
the year in a short format (e.g. 05 
instead of 2005). This Option is 
unavailable if a year is not shown. 

• Short month: Select if you want to 
show month in a short format (e.g. Mar 
instead of March). 

• Short day name: Select if you want to show the day name in a short format 
(e.g. Fri instead of Friday). 

You can follow the link at the bottom of the dialog to go to Regional Settings, where 
you can configure the standard data format. 
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Configuring General Options. Short Date  

In this dialog you can configure the short date 
format for the whole application. 

• Short date format: Look at the sample 
date and change it by selecting or 
unselecting the following: 

• Don't use year: Select or unselect this 
check box if you do or don't want to see 
year in short dates. 

• Short year: Select if you want to show 
the year in short format (e.g. 05 instead 
of 2005). This Option is unavailable if a 
year is not shown. 

You can follow the link at the bottom of the 
dialog to jump to Regional Settings where you 
can configure the standard data format.  

 
 

 

Configuring General Options. Tabs  

In this dialog you can enable as many tabs of 
Spb Diary as you wish.  
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Configuring General Options. Skins  

In this dialog you can select a skin used in Spb 
Diary. Each skin defines the whole appearance 
of Spb Diary Today plug-in, almost all icons 
shown on the Today screen are stored within 
the skin selected. 

 

 

 

 

 

 

 

 

Configuring General Options. Auto Return   

You can set any one of the six tabs of Spb Diary 
Today plug-in as the main one. You can set the 
plug-in to automatically return into this main 
tab after a certain time interval. To do so, select 
the default tab of Spb Diary Today plug-in using 
the View drop-down list and provide the 
desired time interval using the Time-out drop-
down list. 
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Configuring Calendar Options. Common  

• First week of year: Select the best 
option for the first week of the year 
definition:  

o As in regional settings: the first 
week of the year is selected in 
accordance with Regional Settings  

o First 4-day week: the very first 
week that has at least 4 days of 
the new year is declared the first 
week of the year   

o First full week: the very first week 
that has 7 days of the new year is 
declared the first week of the year 

o Starts on Jan 1: the week when 
January 1 happened is considered 
the first week of the year (even if 
January 1 was the very last day 
of that week). 

• Number of days to display: Select the number of days you want to view on 
the Today screen. 

• Collapse all days but today on startup: If selected, all day entries will be 
collapsed, excluding the current day entries. This will happen when Spb Diary 
loads and on every date change. Otherwise the entries will be expanded. 

 

Configuring Calendar Options. Show  

In this option dialog you can select items to be 
placed on the Calendar tab of Spb Diary Today 
plug-in. The items are self-explanatory and do 
not need more detailed explanation. However, 
some details are: 

If you have the Spb Finance application installed 
on your Pocket PC, you can integrate it with Spb 
Diary. If you have any scheduled transaction in 
Spb Finance, they will be displayed in the 
Calendar tab of Spb Diary, if you set the 
corresponding option in this dialog 

The Show "today" always option forces the 
"today" group to be shown even if there are no 
events for this day. This helps to be aware what 
day it is today and it also helps to create new 
items for today 
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Configuring Calendar Options. Tasks   

In this dialog you can select to show tasks on 
your Calendar tab, and if yes, which particular 
tasks to show. 

 

 

 

 

 

 

 

 

Configuring Calendar Options. Titles   

These options define the look of day titles. 

• Show "today", "tomorrow": If you 
keep this checkbox selected, then the 
calendar entries for these two days will 
also include the words “today’ and 
“tomorrow’. If you don’t want to see 
these words on the Today screen, 
unselect this check box. 

• Show time span: Select this check box 
to enable showing the time span. The 
time span is a minimized time rule 
represented with a short thick line that 
allows you to see used and free time and 
to create new appointments.  

• Integrate with Spb Weather: By 
selecting this check box you see some 
weather information in your Spb Diary 
Today plug-in, if Spb Weather is installed 
on your Pocket PC. Spb Diary will take the weather forecast icon from this 
product and add it to the day title lines. 

• Show day offset: (Don't show / Show at left / Show at right): Select if you 
want to see the number of days that separate today's date from the day in 
question. For example, the day after tomorrow has a +2 day offset,  
yesterday's day has a -1 day offset 
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Configuring Calendar Options. View Style   

• Show subject (Always shorten / Always 
expanded / Expand when selected): This 
option defines how to handle long strings 
in appointment subjects and location. 
The "Always shorten" option forces  
showing all the strings shortened to one 
line. The "Always expanded" option 
leaves all the long strings at full length. 
"Expand then selected" is the 
recommended option and forces all the 
strings to be shortened unless you select 
an item. In the latter case all the strings 
are expanded. This option is a good 
compromise between saving screen 
estate and getting full information about 
an item quickly. See the result at the 
bottom of the dialog (please note that in 
the preview "Expand when selected" and 
"Always expanded" look the same). 

• View style (Style 1 / Style 2 / Style 3): Here you can change the general 
style of your appointment list. Select an option and see the result. 

• Show status bar: If you select this check box, then a vertical line will be 
shown along every appointment entry in the list. The color of this bar indicates 
the appointment status, which can be one of Free, Tentative, Busy, and Out Of 
Office 

• Show location: Unselect this checkbox to hide the appointment’s location 
(Office, Home, etc). 

• Only start time: Select this checkbox to hide the appointment’s end time and 
save some screen space.  
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Configuring Calendar Options. Icons   

On this page you can select icons accompanying 
appointments.. These icons provide additional 
visual information about every appointment. 
More actions become available through these 
icons. For example, tapping on the attached 
"note" icon opens a pop-up for this note, and 
the "reminder" icon allows users to quickly 
change the reminder time for a given 
appointment. 

• Icon to the left: Select an icon that will 
be displayed to the left of an 
appointment. 

• Other icons shown: Select other icons 
to go along with calendar entries (if 
applicable). See the sample entry below.  

 

 

Configuring Tasks Options. Common   

• Ask to confirm task completion: Keep 
this check box selected if you want to 
see the confirmation message when 
completing tasks to prevent accidental 
task completion by mistake. 

• Show tasks in all categories: This 
option is important when you group 
tasks by category and some of your 
tasks are associated with more than one 
category. If you select this check box 
then every particular task will be 
displayed within one single category it is 
associated with. Otherwise it will be 
shown within each category it is 
associated with 

• Show active tasks only: If selected, 
then you will see only your active tasks. 
A task is called active if it is not yet 
completed and its start date is today or in the past or it does not have a start 
date at all. 

• Show completed tasks: If selected, the completed tasks will be shown. 

Active tasks: The non-completed tasks, the start date of which is already in the past; 
also the uncompleted tasks where no start date was specified. 

Completed tasks: Tasks that you marked as completed.  
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Configuring Tasks Options. View Style   

• Show subject (Always shorten / Always 
Expanded / Expand when selected): 
Select one of three possible ways to 
display long task subjects in the list. The 
"Always shorten" option forces all of the 
strings to shorten to one line, if needed. 
The "Always expanded" option leaves the 
long strings full length along with all 
icons. "Expand when selected" is a 
recommended option and forces all the 
strings to be shortened unless you select 
an item. In the latter case all the strings 
will be expanded. This option is a good 
compromise between saving screen 
estate and getting full information about 
an item quickly. See the result below 
(please note that in the preview "Expand 
when selected" and "Always expanded" 
look the same way). 

• Show completion check box: Unselect this option to hide the completion 
check box. If it is enabled then you will be able to use it to mark a task as 
completed by tapping the checkbox. If this option is disabled you still can 
complete the task via the context menu. 

• Make date indent: Uncheck this option to disable a date-width indent to the 
left of every task entry to save some screen space (applicable for long task 
subjects) 

See the sample task entry at the bottom of the dialog.  

 

Configuring Tasks Options. Icons   

On this page you can select icons accompanying  

tasks in the list. These icons provide additional 
visual information about every task. More 
actions become available through these icons. 
For example, tapping on the attached "note" 
icon opens a pop-up with this note. 

• Icon to the left: Select an icon that will 
be displayed to the left of a task. 

• Other icons shown: Select other icons 
to go along with task entries (if 
applicable). See the sample task entry 
below.  
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Configuring Contacts Options. Common   

• Search panel (None / Latin / Cyrillic / 
Both): Select if you want to show the 
SmartPhone-like search panel. You will 
be able to search your contact entries 
using this panel. 

• Group by (No grouping / by company / 

by category): Select a grouping method 
for your contacts. Grouping is especially 
useful when you have a lot of contacts. 

• By single tap (No action, Open item, 

Edit item, Show preview): Select an 
action that will be performed on a single 
tap on a contact list entry 

• Show photo contacts: Nothing can 
represent your contacts better that photo 
thumbnails. Representing contacts with 
photos keeps all the functionality, such 
as using search panel, context menu, etc. If you want to represent your 
contacts as small photos, select this check box. In this case all contacts that 
have photos will be put at the top of the contact list. 

• Show contacts in all categories: This option is important only when you 
group contacts by category and have some contacts which are associated with 
more than one category. If not selected, every particular contact will be shown 
only in one category it is referred to. Otherwise it will be shown many times in 
as many categories it is associated with. 

Configuring Contacts Options. View Style  

• Sort by: Select the order of personal 
names to sort contacts within each 
group. 

• View style: Select the style of showing 
contact entries. 
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Configuring Contacts Options. Icons   

At this page you can select icons accompanying 
your contacts in the list. These icons provide 
additional visual information about every 
contact. More actions become available through 
these icons. For example, tapping on the 
attached "note" icon opens a pop-up with this 
note.  

• Icon to the left: Select an icon that will 
be displayed to the left of a contact 
entry.  

• Other icons shown: Select other icons 
to go along with contact entries (if 
applicable). See the sample contact 
entry below.  

• Avoid left indent: This option is 
available when there is no icon shown to 
the left of the item and will save some 
screen real estate. 

 

 

Configuring Notes Options. Common   

• Search panel (None / Latin / Cyrillic / 
Both): Select if you want to show the 
SmartPhone-like search panel. You will 
be able to search your notes entries 
using this panel. 

• Group by (No grouping / By company / 

By category): Select a grouping method 
for your notes. Grouping is especially 
useful when you have a lot of notes. 

• Sort by (Name / Date/Time / Type 

Size): Select a sorting mode factor. 

• By single tap (No action / Open item / 

Show preview): Select an action to be 
performed when you tap a note. The 
default action is to show a note preview. 
In this case a small pop-up window 
appears for quick viewing of the note. 
From this pop-up you can open a full screen note for editing or delete a note 
by using icons in the title bar. 
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Configuring Notes Options. View Style   

• Show note size: Select to enable 
showing the size of note files. 

• Show modification time: Select to 
show the date of the last file modification 

• Make grouping indent: This option 
adds a small left indent to notes in the 
group, which makes viewing groups 
more intuitive. Disable this option to 
save a little screen space. 

See the sample note entry below.  

 

 
 
 
 
 

Configuring Notes Options. Show    

Here you can select what items to show within 
the Notes tab. 

• Standard notes: Select to enable 
showing the standard notes. 

• Recording notes: Select to enable 
showing the audio notes 

• Text files: You can display your text 
files within the Notes tab with the ability 
to quickly open and preview them as 
standard notes. 

• Pocket Word files: You can also add 
your Pocket Word documents into the 
Notes tab 

• PhatNotes notes: Spb Diary can now 
recognize and show PhatNotes notes. If 
you have PhatNotes installed on your 
Pocket PC device you can see them in the Spb Diary Today plug-in 
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Configuring Messages Options.     

In the Messages options you can customize the 
interface of the Message tab of your Spb Diary 
Today plug-in. 

• Sort by: Choose a sorting method for 
displaying   your messages on the Today 
plug-in. 

• By single tap: Select an action to 
perform on a single tap on a message. 
From the preview window you can 
quickly see the message, open it for 
editing, reply, forward or delete it by 
using the corresponding icons in the title 
bar 

• Mark as read on preview: When 
selected, every message will marked as 
"read" if once you have previewed it.  If 
you want to keep the previewed 
messages unread, unselect this check box. 

• Show empty accounts: If selected, you will also see separate entries for 
accounts with no emails in their inbox, or no new emails depending on options 
(if you want to see only unread emails). 

• Show unread messages: If selected, only unread messages will be displayed 
in this tab and they will automatically disappear after you read them. 

Configuring Special Events Options      

In the Special Events options you can customize 
the interface of the Special Events tab of your 
Spb Diary Today plug-in. 

• Show events for next: Provide the 
time interval (from week to year), for 
which the special events will be chosen. 

• Show Birthdays & Anniversaries: 
Select to include birthdays and 
anniversaries into your special events. 
We remind you that all information about 
birthdays and anniversaries is 
automatically taken from your contacts. 

• Show Spb Finance scheduled 

transactions: Select to include 
scheduled transactions into your special 
events. All information about scheduled 
transactions is taken from the Spb 
Finance application, if it is installed on your Pocket PC device. 
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Assigning Category Icons   

To select an icon to be assigned to items within 
a certain category: 

Select a category in the list and then press the 
Add/Change button. You will be asked to 
select an icon. 

When you want to remove an icon for a selected  
category, you can remove it by pressing the 
Remove> button. 

You can also see all entries associated with a 
certain category in a specific color. To assign a 
color to a category, select the category then 
select the desired color. 

 

 

 

 

When you tap the Add/Change button you will 
see the following screen:  

This screen allows you to select an icon to be 
associated with items within a desired category. 
For your convenience icons are put on the 
sample Today screen background so that you 
can see how a certain icon will appear on the 
real Today screen.  

You can show the icon list in full view or in 
compact view using the menu. 

Tap on an icon to select it and then tap ok. 

You can select any icon set stored on your 
device. To do so, open the drop-down menu in 
the top left corner of the screen and select Add 
Icon Set... Then browse your file system for 
the icon set location.  

You will find it very helpfull that category icons 
used in your PIM application are integrated with 
Spb Diary. 
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Configuring Filters    

Your Today screen items can be shown with 
some special filters applied. Look at the 
screenshot on the right: you can select to show 
only appointments of one or more specified 
categories. 

 

 

 

 

 

 

 

 

 

 

To configure these filters:  

1. Tap on the right part of the Spb Diary 
Today plug-in header on the Show 
menu.  

2. Select More… You will now see the filter 
editing dialog. In it, you can configure an 
existing filter or add a new filter. 

3. To specify a new filter, select New Filter 
from the drop-down menu and provide 
the new filter name 

4. Select the categories to pass through 
this filter. You can use the Check All and 
Uncheck All buttons.  

5. Show items matching: 

a. any category: If you selected 
more than one category, then by 
selecting this combo box you will 
show items matching any one of the categories.  

b. all categories: If you selected more than one category, then by 
selecting this combo box you will show only items matching all the 
selected categories 
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6. Add newly created categories to this filter: Mark this check box if you 
want categories you create in the future to be automatically added to this 
filter. Just imagine that you have two categories altogether: "Business" and 
"Personal" and want to create a filter hiding all uncategorized items. In this 
case you would manually mark "Business" and "Personal" check boxes (leaving 
the "Add newly created categories to this filter" unmarked and having the 
"Business+Personal" filter as a result) or tap the "Check All" button and 
unmark the "No Categories" check box (having the "Add newly created 
categories to this filter" marked and having the "-No Categories" filter as a 
result). Both filters described above will work in the same way — they will hide 
all the uncategorized items. So these two filters appear to work in the same 
way but they are different since that have different values of the "Add newly 
created categories to this filter" check box. In order to see the difference 
between them, just imagine that in a couple days of you create a new category 
named "Holiday". Now open the previously created "Business+Personal" filter. 
You will see that the new category is not marked. On the other hand, if you 
open the previously created "-No Categories" filter you will see the new 
category marked. As a result, the "Holiday" items will not pass through the 
first filter and will pass through the second one. So it is recommended to mark 
the "Add newly created categories to this filter" when you create a filter for 
hiding some categories and to leave it unmarked when creating a  filter for 
showing one or several categories.. 

 

Using Spb Diary 

Spb Diary Tabs  

Spb Diary is a Today plug-in for your Calendar 
appointments, Tasks, Contacts, Notes, 
Messages, and Special Events. There are six 
vertically ranged tabs representing these 
groups.  To switch between tabs, just tap the 
desired tab icon.  

 

 

 

 

 

 

 

 

 

 



Spb Diary User Manual  

Copyright 2005-2006 Spb Software House Created March 21, 2005, Updated January 01, 2007 
Page 22 of 39 

 

Using the Calendar Tab  

Here is a typical view of the Calendar tab of 
the Spb Diary Today plug-in. All your 
appointments are displayed on the screen. You 
can also view all your tasks on the Calendar 
tab.  

• Tap the top-left menu to change the 
time period to display. If your header is 
hidden, you can select the time period 
from the context menu. Spb Diary 
allows you to show up to 31 days of 
upcoming events 

• Tap the top-right menu to apply an 
existing filter or to create a new one. 

• If the header is hidden, you can use 
the corresponding commands for 
grouping, sorting and filtering from the 
context menus. 

• Tap the time span icon  next to 
any day title. You can quickly add a 
new appointment with a specified duration. Read the Using Time Span 
section for more information. 

• Tap the calendar button  to view the calendar. Read the Using Spb Diary 
Calendar section for more information. 

• The status bars next to appointments as well as the colored parts of the time 
span indicate the status of your appointments. The status bar can be hidden in 
options. 

• The check boxes next to tasks allow you to mark them as completed. These 
checkboxes as well as task displaying can be changed in program options. 

• The overdue tasks are placed into a separate group. 

• If the subject of an appointment or a task is not fully shown, you can show it 
by simple selecting the appointment or task. The long subject behavior can be  
changed in program options. 

• Many icons may accompany your appointments and tasks. For example the 

notes icon  shows notes when tapped; and the reminder icon  allows you to 
quickly modify the alarm settings when tapped. 

• If you assigned a particular icon to a category, it will be attached to all items 
within this category. An icon can be assigned in Category Icons options. For 
example, the icon  in the screenshot marks the Business category of the 
task. 

• Double-tap on an item to open it for viewing or editing (this behavior depends 
on the corresponding option) 
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• A number of actions can be performed 
from the context menus. Here is an 
example of the context menu for the day 
title. You can quickly create a new 
appointment or a task for the selected 
day. If, currently, a certain simple filter 
is applied (e.g. showing all items within 
the Personal category), then the newly 
added appointment or task will be within 
the same category. This appointment or  
task automatically applys to the currently 
selected filter or open Calendar or Tasks 
in the integrated PIM application. The 
Collapse item allows you to collapse the 
selected day contents into one line. The 
Collapse All menu item allows you to 
collapse all days contents. The Expand 
and Expand All commands allow you to 
expand the contents of one or all day 
groups. 

• Here is an sample of the context menu 
for an appointment. From this menu you 
can quickly beam an appointment or 
send it via Bluetooth. The Modify item 
has submenus allowing you to 
reschedule the appointment, change the 
reminder settings, change the 
appointment status or mark it as Private. 
This context menu may include other 
actions registered in the system (e.g. 
Repeating Alarms if Spb Pocket Plus is 
installed on your device). 
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• Here is a similar context menu for a task 
(with submenus) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using Spb Diary Calendar  

If you double-tap on the Calendar tab icon  
you will see a specially designed Spb Diary 
calendar. 

• If there is at least one appointment or 
task for a certain day, then this day on 
the calendar will contain a time span 
which has a colored section, which 
reflects the duration of the appointment  
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• To change the month to display, tap on 
the month name. 

 

 

 

 

 

 

 

 

 

• To change the year to display, just tap 
on the year. 

 

 

 

• To jump to previous or next month, use  and  buttons 

• To return to the current date, tap  

 

• If you want to create an appointment or 
a task for a certain day, just tap on this 
day and select a corresponding item 
from the pop-up menu. 

• If you want to create an appointment or 
a calendar task that should last for 
several days, just move your stylus 
along the desired time interval (including 
several days) and then select Create 
Appointment or Create Task from the 
pop-up menu. 

• If you want to see calendar 
appointments and tasks for a certain 
time interval, select this interval with 
your stylus and then select Load Selection from the pop-up menu. 

• If you want to see calendar appointments and tasks for a certain month (e.g. 
July), make sure you are in that month, tap on any day and select Load July 
form the pop-up menu. 

• If you want to see calendar appointments and tasks for a certain week 
(weeks), just select a day (days) of this week (these weeks) and select Load 
Week (Load Weeks) from the pop-up menu. 
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Using Spb Diary Time Span 

 
The Time span allows you to quickly add an 
appointment for a certain day. To do so: 

1. Tap on the Time span icon next to the 
desired day.  

 

 

 

 

2. You will see a time span allowing you to 
specify the duration of a new 
appointment.  

 

 

 

 

 

 

 

 

3. Drag your stylus along this time span to 
capture a period of time.  

4. Select Create Appointment. 
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5. You will be asked to create an 
appointment for the selected period of 
time. 

6. Later on you can change the status of 
the created appointment, and the time 
span will indicate this status by coloring 
the appointment. The color of the status 
is selected in accordance with the PIM 
application integrated with Spb Diary. 

 

 

 

 

 

 

 

 

Using the Tasks Tab 

Here is a typical view of the Tasks tab of the 
Spb Diary Today plug-in. It contains all your 
tasks. 

• From the top-left menu you can select a 
grouping and sorting order for your 
tasks. The sorting order depends on the 
selected grouping mode. In this 
screenshot the tasks are grouped by 
Category.  

• Similarly to the Calendar tab you can 
create and apply filters for your tasks. 
Filters are applied from the top-right 
menu. From this menu you can also 
select whether to show active tasks only 
and whether to show the completed 
tasks. 

• If the header is hidden, you can use the 
corresponding commands for grouping, 
sorting and filtering from the context 
menus. 

• Icons behave the same as on the Calendar tab. 

• You can change the reminder time for any task (the standard task time is 

8:00). Just tap  and provide the new reminder time for the task. 

• The active tasks are shown in bold. 

• The overdue tasks are shown in italic. 

• The completed tasks are shown in strikethrough mode. 
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• Long task titles can also be viewed in full 
when selected (optional). 

• Tap on the notes icon  to view notes for 
the desired task in a pop-up window.  

 

 

 

 

 

 

 

 

 

• As in the Calendar tab a number of 
actions can be performed from the 
context menus. Here is a context menu 
for a grouping line (in this case – for the 
category). From this context menu you 
can quickly create a new task. If your 
tasks are grouped by category (as on 
this screenshot), then the newly created 
task will be within the same category, 
which makes this a very useful feature. 
From the context menu you can also 
open your tasks in the corresponding 
PIM application. The Expand, Expand All, 
Collapse, and Collapse All items allow 
you to expand or collapse the contents of 
one or all grouping lines. 

 

• Here is a context menu for a single task. 
The actions represented in this menu are 
clear. The Modify menu item contains 
submenus allowing you to change the 
date and reminder settings for the task, 
change its priority, mark it as private, or 
mark it as completed. The Make a Copy 
menu item allows you to quickly 
duplicate the task, which can be  
rescheduled or edited. This menu also 
contains other actions selected else 
where in the system. 
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Using the Contacts Tab 

Here is a typical view of the Contacts tab of the 
Spb Diary Today plug-in. It contains all your 
contacts. 

• If you want to display your contacts as 
thumb nail photos please configure the 
corresponding option (Options -> 

Contacts -> Common tab). Usually 
users will assign photos only to the most 
important people in their contacts lists. 
These photo contacts are displayed at 
the very top of the list and can be 
quickly accessed. 

In Windows Mobile 5.0 a photo is a 
associated with a contact. So photos 
become a normal part of contacts. For  
previous OS versions there are two 
supported exceptions 

o If Pocket Informant is installed, 
then photos supported by this 
program can also be shown in Spb Diary. 

o The second exception works on HTC devices with the CallerID 
application installed. Photos assigned in HTC CallerID will also be shown 
in Spb Diary. 

• The most frequent actions with contacts 
can be achieved via a very useful pop-up 
window. Just tap on a contact to see the 
pop-up window. You will be able to dial 
the mobile or home phone number or to 
send an email or a text message. 
Therefore dialing a person’s number or 
sending a message is a two tap process 
in Spb Diary. 

• Contacts can be grouped from the top-
left menu. Grouping can be performed by 
company name, by category or not 
grouped at all. 



Spb Diary User Manual  

Copyright 2005-2006 Spb Software House Created March 21, 2005, Updated January 01, 2007 
Page 30 of 39 

 

 

• From the top-left menu you can also 
select the sorting order: either by the 
first name or by the last name of a 
person. The contacts can also be sorted 
by the File As parameter (used in 
desktop Outlook, Agenda Fusion, and 
Pocket Informant). In this screenshot 
contacts are grouped by Category and 
sorted by the last name 

• Filters for contacts are available from 
the top-right menu. From this menu you 
are also able to create a new filter for 
contacts. 

• If the header is hidden, you can use the 
corresponding commands for grouping, 
sorting and filtering from the context 
menus. 

 

• For any person in your contact list you can select a contact that will be 
displayed constantly on the Today screen. To select a desired contact (a phone 
number or an email address):   

1. Open the Contacts tab and find a desired contact. 

2. You can see a small icon representing the kind of a displayed phone 
number (home, office, mobile, etc). Tap on this icon. 

3. You will be shown the list of all existing phone numbers and e-mail 
addresses for this person. Just tap the one you want to be constantly 
displayed. 

• There are also powerful context menus 
for the Contacts tab. Here is a general 
context menu of the Contacts tab. From 
this context menu you can open your 
contacts in the integrated PIM 
application. 
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• The context menu for a particular group 
allows you to quickly find a contact 
matching within this group. Use the 
Collapse, Collapse All, Expand, and 
Expand All commands to collapse or 
expand the contents of one or all groups. 

 

 

 

 

 

 

• The context menu of a single contact 
provides you full control over a contact. 
The commands of this menu shown on 
this screenshot are quite self-
explanatory. If a person in your contact 
list has an e-mail address, the Send 
Email item appears in this menu, which 
allows you to be able to quickly write an 
email to a contact directly from the 
Today screen. The Dial via Bluetooth 
item allows you to make an phone 
connection with this contact via 
Bluetooth. This menu can also contain 
some additional actions located else 
where in the system (e.g. in Phone 
Editions: Send SMS, Dial, and more). 

 

 

 

Using the Search Panel of the Contacts Tab 

• You can quickly find a desired person in your contact list using the 
Smartphone-like search panel at the bottom. By tapping the first characters of 
somebody’s name you can narrow down the list of the displayed contacts 

For example, if you want to find some 'Monroe, Jules', you should tap the 
[mno] button. You will see the list of all entries starting with 'm', 'n', or 'o'. If 
the list is still big enough, tap this button again (because the second character 
of 'Monroe' is 'o'). The list will narrow down to all names starting with only 
'mm', 'mn', 'mo', 'nm', 'nn', 'no', 'om', 'on', 'oo'. You can keep narrowing this 
list down until you find the desired name. In order to delete the typed symbols 
you can use the backspace “<<” button. 
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• The search panel can represent Latin and 
Cyrillic alphabets or both. In case of both 
alphabets selected, there also appears a 
switcher, which makes switching the 
current alphabet a really easy option 
(very useful for those whose native language is Russian, but who has a lot of 
foreign contacts). 

• Almost all European languages are supported. The accented letters even 
though not displayed are still processed. For example, the German “ß” is 
handled by the “pqrs” button, while “mno” buttons handles all of 
“mnoñòóôõö”. 

 

Using Hardware Keys for Contacts 

Spb Diary provides full stylus-free control over the Today plug-in. By using the 
hardware keys you can move through the contact list. Using the Action button you 
can open pop-ups for your contacts. Moreover, Spb Diary provides a brand new 
concept – Action-and-Hold, the hardware analog of the Tap-and-Hold action. If you 
have a contact selected you can open the context menu by holding the Action button. 
This feature allows you to get fast hardware access to any program function. Even the 
search panel is available via hardware keys. Read more in the Using Hardware Keys 
section. 

 

Using the Notes Tab 

The Notes tab contains all your notes – the 
fourth important component of PIM data. Here 
is a typical view of the Notes tab. 

• Notes can be grouped by using the top-
left menu. Grouping can be selected by 
date and time, by folder or not grouped 
at all. 

• From the top-left menu you can also 
select the sorting order: by note name, 
date and time, type, or size. 

• Filters for contacts are available from the 
top-right menu. From this menu you are 
also able to create a new filter for notes. 

• If the header is hidden, you can use the 
corresponding commands for grouping, 
sorting and filtering from the context 
menus. 



Spb Diary User Manual  

Copyright 2005-2006 Spb Software House Created March 21, 2005, Updated January 01, 2007 
Page 33 of 39 

 

• The context menus in the Notes tab 
provide you with many possible 
commands and actions. Here is an 
example of a particular note context 
menu. 

 

 

 

 

 

 

 

 

 

 

 

 

When you tap the icon of a note you will be 
shown a small preview picture as in the 
screenshot. Text notes can be copied into 
the clipboard. 

 

 

 

 

 

 

 

 

 

Spb Diary starting from version 2.0 supports viewing text files, Pocket Word files 
and PhatNotes notes within the Notes tab. By default these files are displayed. 
If you don’t want to display them, configure the corresponding option.  

FAQ. Which files are shown in the Notes tab of Spb Diary Today plug-in? 

Answer. Spb Diary searches for files only in the same folders as Pocket Word 
and standard Notes do. If a note is shown by standard Pocket PC Notes, it will 
be shown in Spb Diary, too. If a Pocket Word or a text file is shown in Pocket 
Word application, it will be shown in Spb Diary, too. Files stored in other 
folders will not be shown. 
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• To quickly listen to an audio note, just 
tap it. 

 

 

 

 

 

 

• Spb Diary supports note conversion. You 
can convert a note into an appointment, 
task or contact via the context menu. 
Conversion means that you can quickly 
create a new appointment, task or 
contact by looking at the note. For 
example, you had little time to write 
down someone's phone number. You 
write it in a new note and later choose to 
convert this note into a contact. You 
don't need to remember the phone 
because when converting, the number is 
in front of your eyes. 

 

 

 

 

Here is an example of a note being 
converted to a contact. 
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Using the Messages Tab 

The Messages tab contains all your email, SMS 
and MMS messages. You can perform different 
operations with messages: read, delete, reply, 
and forward to other recipients, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

• To quickly preview an email message, 
just tap on its entry in the list. You will 
be shown a pop-up window. The pop-up 
window contains the message sender 
name, email address, date, message 
subject and body. The pop-up window 
allows you to handle the message: reply 

(tap ), reply all (tap ), forward 

(tap ), delete (tap ), and open in 

editor (tap )   

• If you want to quickly synchronize your 
messages, tap-and-hold on the Messages 

tab icon ( ) and select 
Synchronize Mail from the context 
menu. 

 

 

 

• Similarly to notes in the Notes tab you 
can copy to clipboard texts from the pop-
up message window. 
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• If you tap on any text message you will 
also be shown a pop-up window with a 
message preview. A Reply, Forward, 
Delete and Open actions that can be 
performed from this pop-up, you can 

also call the sender by tapping .  

 

 

 

 

 

 

Using the Special Events Tab 

Special events is a separate tab of Spb Diary 
Today plug-in. The Special Events tab is the 
best way to quickly overview all birthdays and 
anniversaries of people from your contacts 
and/or your scheduled money transactions for a 
set period of time. 

• Contact entries within the Special Events 
tab can be treated as normal contacts, 
with the ability to see their profiles, dial 
their phone numbers, send messages, 
etc. Just tap a contact entry (either a 
birthday or a anniversary) to see the 
pop-up with options to dial the person’s 
number or send a message. 

• Scheduled transactions from the Special 
Events tab can be treated as in the 
Calendar tab. To quickly open the 
Scheduled Transactions view of Spb 
Finance, tap-and-hold on a scheduled 
transaction entry and select Open Spb Finance. 

• To change the time span for showing special events, use the top-left menu. 
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•  

 

• To ungroup entries, select No Grouping 
from the same menu.  

 

 

 

 

 

 

Using Hardware Keys 
Spb Diary supports full hardware control. Almost any program action can be 
performed by means of the five hardware buttons (navigation and action). Here are 
common actions that can be performed with hardware keys: 

• To move through the plug-in tabs and list items use the Up and Down keys. 

• To emulate the stylus tap, press the Action key 

• To emulate tap-and-hold, use action-and-hold (press and hold the Action 
button for about a second) 

• Within the Contacts and the Notes tabs to get to the search panel, use the 
Right key. To move by the search panel use the Left and Right keys. To 
emulate the stylus tap on a letter group use the Action key. 

Since the Today plug-in of Spb Pocket Plus can also be controlled with hardware keys, 
you can successfully use them even if Spb Diary is integrated into Spb Pocket Plus 
Today plug-in. 
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Integration with Spb Weather   
If you have Spb Weather installed on your 
Pocket PC with the Today plug-in activated, you 
will see a small weather icon near the day titles 
in the Calendar tab. Spb Diary takes the 
weather forecast information for each day from 
Spb Weather for the city currently active in that 
application. If you change the active city in Spb 
Weather, then Spb Diary will change its look. 

If you tap the weather icon in the Spb Diary 
Today plug-in you will see a pop-up window 
with the detailed weather information for that 
day taken from Spb Weather.  

To disable showing the Spb Weather 
information, configure the corresponding 
calendar tab option. 

If you don’t have Spb Weather installed on your 
device we would recommend you read about 
this application at 

http://www.spbsoftwarehouse.com/products/weather/ 

Integration with Spb Finance   
If you have Spb Finance installed on your 
Pocket PC, you can configure Spb Diary to show 
scheduled transactions of Spb Finance. To 
integrate, open Options -> Calendar -> Show 
and select the Spb Finance scheduled 

transactions check box. Every transaction 
scheduled for a particular day will be shown 
within this day entry in the Calendar tab. 

You can also add all your future scheduled 
transactions to the Special Events tab. To do so, 
open Options -> Special Events and check 
the Show Spb Finance scheduled 

transactions check box. 
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Integration with Spb Pocket Plus 
Spb Pocket Plus 3.0 and higher allows users to 
perform different functions with its tabs. One of 
the main features of the new Pocket Plus 
version is close integration with Spb Diary and 
other Spb products. 

Representing Spb Diary Today plug-in in the 
form of a tab in Spb Pocket Plus is very 
important for the optimization of the screen 
area.  

You have a choice either to have a separate 
Spb Diary Today plug-in on your screen, or to 
have it integrated into Spb Pocket Plus. 

You can select any number of Spb Diary 
components as tabs of Spb Pocket Plus. You 
can even integrate all of them – your Calendar, 
Tasks, Contacts and Notes will appear in the 
Spb Pocket Plus Today plug-in as separate tabs. 

To add a new tab in Spb Pocket Plus, tap-and 
hold on the tab header. You will see a New 
Tab> menu with several possible tabs. Select 
one of Spb Diary tabs and it will appear in the 
Pocket Plus Today plug-in. 

 

 

This is how the Spb Pocket Plus Today plug-in 
looks with several Spb products embedded. 

In the Spb Pocket Plus plug-in you can reorder 
these tabs, rename them, customize their width, 
insert additional shortcuts into them, change 
icons, etc – treat them like any other Pocket 
Plus tabs. 

If you want to extract Spb Diary tabs from the 
Spb Pocket Plus plug-in, just delete them all and 
the Spb Diary Today plug-in will appear on the 
screen again. 


